xecell Lab

Trade Name

Idebenosome RC-200

INCI Name

Water, Butylene Glycol, Glycerin, Hydrogenated Lecithin,
Caprylic/Capric Triglyceride, Hydroxydecyl Ubiquinone, 1,2-
Hexanediol, Glycine Soja (Soybean) Sterols, Panthenol

Recell Lab's Products

Properties

Idebenone promotes cell growth, protects cells, and reduces various effects. Idebenone plays a role in
promoting activity from the dermal layer to layers other than collagen and elastin. Like It has the function of
alleviating melanin production and relieving the skin or softening the skin, and is effective in improving elasticity,
removing wrinkles, and improving skin tone.

ckage

Tkg/bottle, Skg/barrel

Asiaticobenosome

Water, Centella Asiatica Leaf Extract, Citrus Aurantifolia
(Lime) Fruit Extract, 1,2-Hexanediol, Butylene Glycol,
Glycerin, Hydrogenated Lecithin, Caprylic/Capric
Triglyceride, Glycine Soja (Soybean) Sterols,
Hydroxydecyl Ubiquinone, Panthenol

» Exquisite combination of anti-inflammatory ingredients and idebenone

Tkg/bottle, Skg/barrel

Water, Isopentyldiol, Propanediol, Polyglyceryl-4 Oleate,

> A natural key for an healthier skin preventing the ageing signs.

RC Atico 10000 o X . . L 20kg/bucket
Asiaticoside, SodiumStearoyl Glutamate > Firming, anti-wrinkle and nourishing effect
. Water, Glycerin, Caprylic/Capric Triglyceride, Bakuchiol, . . . - L " .
RC Bakutinol A10 X » Natural active material that exhibits anti-aging effects like retinol. Tkg/bucket
Octyldodecanol, Polyglyceryl 4 Oleate, 1,2 Hexanediol . . . . ) . .
- - - » Bakuchiol has similar aging-improving effects to retinol and has a very good stability than retinol.
. Octyldodecanol, Pentaerythrityl Tetraisostearate Bakuchiol, L . . . A
RC Bakutino 010 » Bakuchiol imparts retinol efficacy to the skin without side effects. Tkg/bucket

Isoamy! Laurate , Cetyl Ethylhexanoate

Water, Butylene glycol, Pentylene Glycol, Sodium DNA,

RC DNA(10) - ) o o o . ) o Tkg/bottle, Skg/barrel
Isopentyldiol Tissue regeneration(anti aging, restructuring, rejuvenation, anti-wrinkle, whitening, enhancing elasticity, hair
Water, Butylene Glycol, Isopentyldiol, Pentylene Glycol, rowth, ets]
RC DNA(s) i Y] 4 penty| 4 Y 9 ) 1kg/bottle, Skg/barrel
Sodium DNA
> Fructan is a general term for homopolysaccharides composed of fructose, and is a polysaccharide based on
. research on D-fructose.
Water, Butylene Glycol, Isopentyldiol, Fructan, 1,2- o . N . - .
RC Fructan i . . > Helps soothe and moisturize the skin. Helps form a film. Increase hydration. Helps stabilize cosmetic 20kg/barrel
Hexanrdiol, Sodium Surfactin N
emulsions.
» May act as a film former when used in skin care products.
» Fullerene liposomes have a protective effect on UVA induced collagen I and IV damage.
RC Fullerene C60 Fullerenes, Water » Fullerene has a good protective effect on UVB induced cell damage. Tkg/bottle
» Effect of fullerene on UVB induced mouse skin Skin erythema has obvious inhibitory effect.
» An opaque milky white gel-type formulation.
RC Gl 0.1M 10kg/barrel
usome . . . Dispersed in water (Water-Soluble & Easy to USE) — Increased compatibility g/barre
Isopentyldiol, Butylene Glycol, Propanediol, Polyglycerin-3, . X § . L
K . ) Strong stability against temperature and light — Formulation stability improved
Glutathione, Sodium Surfactin > Anti-aging: P " ing b i I d d by dical
RC Glusome 0.5M > n |—.agmg. revents ag.\r?g y pre.ven ing ce. amag.e causes . y free ra \.ca s. . 3 10kg/barrel
» Skin improvement: Inhibits melanin production to brighten skin tone and improve skin elasticity.
> Phloretin been optimized to be suitable for water-soluble liquid application.
> RC Phloretin Aqua stimulates the synthesis of essential proteins and fibers and accelerates cell turnovers to
correct existing damage.
X Water, Isopentyldiol, Propanediol, Polyglyceryl-4 Oleate, > Skin whitening: inhibition of tyrosinase activity and melanin precipitation, skin pigmentation whitening can
RC Phloretin Aqua 10kg/barrel

Phloretin, SodiumSurfactin, Sodium Stearoyl Glutamate

also have a significant synergistic effect with albutin or cozic acid, and can significantly increase tyrosinase
inhibition.

> Phloretin, a powerful antioxidant, can remove free oxygen, prevent aging, prevent cell mutations, promote cell
metabolism, reduce wrinkles, increase skin support structures, and enhance skin immunity to UV rays.

RC VBE

Vanillyl Butyl Ether

» It has good skin affinity and can penetrate the skin slowly.

» The pleasant warming effect is mild and long-lasting.

» It increases skin temperature, promotes subcutaneous fat burning, and promotes microcirculation to slim the
body.

5kg/AL bottle

Recell Bio SH-100(H)

Water, Sodium Hyaluronate, 1,2-hexanediol,
Ethylhexylglycerin

» Maintain skin volume 3> Excellent moisturizing effect » Action that helps the metabolic process of cells
» Antioxidant effect that suppresses free radical activity caused by various causes.

20kg/bucket, 200kg/drum

Recell Bio Super SH8

Sodium Hyaluronate, Hydrolyzed Sodium Hyaluronate,
Hydrolyzed Hyaluronic acid, Hyaluronic Acid, Sodium
Acetylated Hyaluronate, 1,2-Hexanediol, Butylene Glycol,
Pentylene Glycol, Hydroxyacetophenone, Water

» Three-dimensional sponge layer structure. > Precisely locate different levels of the skin.
» Three-dimensional moisturizing effect.

20kg/bucket

Recell TECA 10

Isopentyldiol, Propanediol, Water, Polyglyceryl-4 Oleate,
Asiaticoside, Madecassic Acid, Sodium Surfactin, Asiatic

Acid, Madecassoside, Centella Asiatica Extract

TECA is one of the most studied extract of Centella asiatica by the scientific community and the most used by
the Cosmetic industry. TECA's properties and applications based on the scientific literature:

> Anti-Wrinkle Properties: TECA contains asiaticoside, which stimulates collagen synthesis, leading to improved
skin elasticity and reduced wrinkle depth.

> Firming Effects: The presence of asiatic acid and madecassic acid enhances fibronectin and collagen synthesis
by up to 35%, contributing to firmer skin.

> Repairing Effects: Asiaticoside promotes wound healing by stimulating extracellular matrix accumulation,
including increased dry weight, DNA, total protein, collagen, and glycosaminoglycan contents in wounds.

» Anti-Inflammatory Properties: TECA reduces inflammation through decreased levels of inflammatory
cytokines like TNF-alpha, IL-1B, and IL-4, aiding in tissue repair without excessive scarring.

» Antioxidant Activity: The extract protects against UVB-mediated damage via regulation of miRNA expression
profiles, reducing oxidative stress that can lead to premature aging.

» Skin Health Improvement: By enhancing cellular redox status and reducing ROS production, TECA prevents
hydrogen peroxide-induced senescence in skin cells, maintaining youthful appearance.

> UV Protection: It offers a protective effect against UVB damage by altering microRNA expression profiles in
human dermal fibroblasts, preserving cell viability under UV exposure.

Tkg/bottle, Skg/barrel

Spongilla Spicule Powder RC-5002

Hydrolyzed Sponge

Spongilla Spicule Powder RC-5003

Hydrolyzed Sponge

Spongilla Spicule Powder RC-5103

Hydrolyzed Sponge

The spongilla spicules is a cosmetic active ingredient that has been purified from the sponge and extracted
through biotechnology.

» Painless: Implantation by application. No significant pain.

» Invisible: Like a needle, but not Invisible and touchable.

» Noninvasive: Non-instrumental needle no trauma, no bleeding, no anaesthesiarequired.

> Effective: A differentiated feeling. A remarkable effect.

1kg/AL bag

1kg/AL bag

1kg/AL bag




xecell Lab

Proteo Plus

Water, Butylene Glycol, Isopentyldiol, Pentylene Glycol,
Soluble Proteoglycan

Proteoglycans are a major component of the animal extracellular matrix, a "filler" substance that exists between
the cells of an organism, where they form large complexes with other proteoglycans and fibrous matrix proteins
such as hyaluronic acid and collagen.

» Aging care EGF action.

» Promotes production of hyaluronic acid and type 1 collagen: powerful wrinkle improvement function.

» Powerful moisturizing power up to 130% of hyaluronic acid.

> Skin regeneration function (EGF / FGF Like Effect). > Binding function with hyaluronic acid.

10kg/barrel

IMPORT MATERIALS

Trade Name

Sodium Hyaluronate 1.50MDa

INCI Name

Sodium Hyaluronate

Shandong Galaxy Bio-Tech Co., Ltd

Properties

» Long term moisturizingaction and works to sustain stable emulsion, with thickening effect.

Package

. . - . L ) 1kg/AL ba
. . » A smoothing daily moisturi zer. It nourishes and hydrates the skin with all day long efficacy. 9 9
Sodium Hyaluronate 1.30MDa Sodium Hyaluronate
. . » It can penetrate into the dermis, promote skin absorption ofnutrients, with strong wrinkles reduction, increase
Sodium Hyaluronate 0.30MDa Sodium Hyaluronate X . i i 1kg/AL bag
skin elasticity, delay skin ageing.
Sodium Hyaluronate 10KDa Sodium Hyaluronate » Long-term moisturizing action and works to sustain stable emulsion,with,thickening effect.
1kg/AL bag
Sodium Hyaluronate Oligosaccharides Sodium Hyaluronate » It has many biological activities, such as transdermal absorption, moisturizing, repairing, anti-oxidation, etc.
. . . . > Deep absorption, skin nourishment, anti-wrinkles.
Hyaluronic Acid 10KDa Hayluronic Acid o . . o . 1kg/AL bag
» Good moisturizing property, and transdermal absorption capability, nourishing the skin deeply, etc.
. . . X » Hydrolyzed form of hyaluronic acid > Has a lower molecular weight than hyaluronic acid
Hydrolyzed Hyaluronic Acid 10KDa Hydrolyzed Hyaluronic Acid i . o i 1kg/AL bag
» More readily penetrates skin > Good moisturizing ingredient
. . » Owns both lipophilic and hydrophilic properties , promote high affinity and adsorption properties for skin,
Sodium Acetylated Hyaluronate Sodium Acetylated Hyaluronate L T 8 . . 1kg/AL bag
repair skin barrier, improve skin elasticity, and leave skin smooth.
» The Cationic Hyaluronate modified with the cation has a positive charge, which can attract the negative
Cationic Hyaluronic Acid Hydroxypropyltrimonium Hyaluronate charge of human hair surface, It can be well adsorbed on the hair surface and is resistant to washing. Therefore, 1kg/AL bag
it can fully exert the moisturizing function of HA.
> Potassium Hyaluronate is the potassium salt form of hyaluronic acid, a glucosaminoglycan, a component of
Potassium Hyaluronate Potassium Hyaluronate connective tissue, skin, vitreous humour, umbilical cord, synovial fluid and the capsule of certain microorganisms 1kg/AL bag

contributing to adhesion, elasticity, and viscosity of extracellular substances.

IMPORT MATERIALS

BEIJING BRILLIANCE BIOTECH CO., LTD.

Trade Name INCI Name Properties Package
Brillian-MB218 Kojic Acid Kojic Acid » Water soluble > Whitening - Inhibition of tyrosinase by combining with copper ions 1kg/AL bag
. = o . = o . » Oil soluble » Whitening - Inhibition of tyrosinase by combining with copper ions > Promotes skin
Brillian-MB228 Kojic Acid Dipalmitate Kojic Acid Dipalmitate R . 1kg/AL bag
metabolism > Safety and stability
- . . . . » Water soluble > Whitening - Inhibits protease action on Catalytic effect of peptide bond hydrolysis
Brillian-MB258 Tranexamic Acid Tranexamic Acid . . . 1kg/AL bag
» Scavenges hydroxyl radicals and superoxide radicals
Brillian-MB221 Ultrafine Azelaic Acid Azelaic Acid » Anti-acne » Whitening > Keep skin elasticity and brightening Tkg/AL bag
Brillian-MB222 ) - ) _— I, ) L
X o Potassium Azeloyl Diglycinate » Water soluble > Anti-acne » Whitening - Competitive inhibition of tyrosinase activity 1kg/AL bag
Potassium Azelaoy! Diglycinate
Derivative closer to azelaic acid, Good mildness, sensitive skin friendly Non-stimulation, no itch, no red, Good
Brillian-MB224 Azelamide MEA Azelamide MEA water solubility, solving the problem of insolubility of azelaic acid in water and oils. 1kg/AL bag
> Oil control > Anti-bacterial > Rapid spot removal > Remove blemishes and whiten skin.
Brillian-MB280 . » Water soluble > Whitening - decrease tyrosinase activity By eliminating excess nitric oxide from the skin
X Raspberry Ketone Glucoside o 1kg/AL bag
Raspberry Ketone Glycoside » Anti-aging
Brillian-KS60 Slow Released Retinol Hydroxypropy!l Cyclodextrin, Retinol > Disperse with butylene glycol > Improve rough skin > Anti-wrinkle > Anti-aging 1kg/AL bag
Propylene Glycol, Hydroxypropyl Cyclodextrin, PPG-5-
Brillian-KS68 Skincare Additive CETETH-20, Water, Retinol, Adenosine, » Water soluble > Anti-aging > Repair damaged cells > Remove dark circles Tkg/bottle
Hydroxyacetophenone, 1,2-Hexanediol
Dimethyl Isosorbide, Retinol, Caprylic/Capric Triglyceride, |Anti-Aging liquid gold / Qil souble Retinol
Brillian-KS301 Retinol 30 4 prylic/Cap g 9 g_ quid gold / o L . Tkg/bottle
Tocopherol » True Retino 30% By HPLC > No solidification or precipitation at low temperatures > 180 days stability test
Brillian-AZ136 Laurocapram Laurocapram > Oil soluble » Transdermal absorption promoter 20kg/barrel
Sophora Angustifolia Root Extract, Polysorbate 80, > Water Soluble > Anti-acne > Whitening - Competitive inhibition of tyrosinase activity
Brillian-QD365 Skincare Additive Propylene Glycol, Potassium Azeloyl Diglycinate, Capryloyl | > Promote the stratum corneum shedding »> Restore skin smooth and delicate Tkg/bottle

Salicylic Acid, Phenoxyethanol, Ethylhexylglycerin

» Reduce fine lines and wrinkles 3> Keep skin elasticity and brightening.

Brillian-KS38 Vitamin A Acetate

Retinyl Acetate

» Oil soluble » Anti-wrinkle » Improves skin > Delays skin aging

Tkg/bag, 10kg/barrel,
20kg/barrel

Brillian-KS100 Vitamin A Palmitate

Retinyl Palmitate

> Oil soluble » Anti-aging > Improve Skin > Selays skin aging

1kg/bag, 5kg/bag

Brillian-KS26 Capryloyl Glycine

Capryloyl Glycine

> Oil soluble » Anti-aging » Anti-bacterial > Inhibits excess sebum production » Effective prevention and
treatment of acne. > Hair conditioning

1kg/bag, 10kg/barrel,
20kg/berrel

Brillian-VAA Tretinoin

Retinoic Acid

> Oil soluble » Anti-acne > Stimulate skin cell growth. » Promote cell metabolism and reduce fine lines and

wrinkles. > Reduce aging pigment content. > Restore skin smooth and delicate.

0.1kg/bag, 1kg/bag

Brillian-BSJ Hydroxyethyl Urea

Hydroxyethyl Urea

» Water soluble » Moisturizing > Hair conditioning > Better hygroscopic ability compare with glycerin or
other hygroscopic agents. » Restore skin smooth and elasticity.

Tkg/bag, 10kg/barrel,
20kg/berrel




Recell Lab

Brillian-KY11 Alpha-Bisabolol

Bisabolol

> Oil soluble » Anti-allergic

1kg/bottle, 10kg/bottle

Brillian-PD 135 Pyridoxine Dipalmitate

Pyridoxine Dipalmitate

» Oil soluble » Anti-acne » Anti-rough skin and anti-sunburn > Prevention and treatment of seborrheic hair

Tkg/bag, 10kg/barrel,

loss 20kg/berrel
- - R o . > Oil soluble » Anti-acne » Promote the stratum corneum shedding. » Restore skin smooth and delicate. > 1kg/bag, 10kg/barrel,
Brillian-CSA Capryloyl Salicylic Acid Capryloyl Salicylic Acid o i ) . K )
Reduce fine lines and wrinkles. > Keep skin elasticity and brightening. 20kg/barrel
Brillian-WCSA Capryloyl Salicylic Acid, Water, Polysorbate 80, PEG-40
rillian-
Hydrogenated Castor Qil, Triethanolamine, Phenoxyethanol,|> Water soluble > Anti-acne > Exfoliation > Improves skin > Reduces wrinkles Tkg/bottle

Water Soluble Capryloyl Salicylic Acid

Ethylhexy! glygerin, Disodium EDTA

IMPORT MATERIALS

Trade Name

INCI Nam

Xi'an Natural Field Bio-Technique Co., Ltd.

Properties

» Strengthening immune function > Important for detoxification » Removal of carcinogens
> Antioxidant cell protection > Protects against ionizing radiation » DNA synthesis and repair

Glutathione Glutathione . . . X X X L . Tkg/AL bag
> Protein synthesis > Prostaglandin synthesis > Leukotriene synthesis > Enzyme activity and regulation
» Amino acid movement
» Idebenone is attracting attention as a powerful antioxidant.
» Idebenone, which is excellent for promoting cell growth, cell protection, and antioxidant effects, plays a role in
Idebenone Hydroxydecyl Ubiquinone promoting the regeneration of not only collagen and elastin in the dermal layer but also the moisture layer. > Tkg/AL bag
In addition, it has the function of suppressing skin pigmentation by suppressing melanin production, reducing
skin discoloration or brightening the skin, and is effective in improving elasticity, wrinkle removal, and skin tone.
» Prevents whole body aging by activating longevity genes > Regeneration of weakened skin
o . . » Hair loss improvement > Promotes cellular energy and extends cell life
NMN Nicotinamide Mononucleotide . . : 1kg/AL bag
» Can alleviate various aging symptoms
» It suppresses various skin declines caused by aging, such as wrinkles, sagging, and dandruff.
> Improves skin elasticity, firmness and radiance, suitable for stressed skin
> Provides strong UV radiation protection. > Increases the Aerobic Capacity, potent antioxidant capability
» RSV enhanced mitochondrial enzymatic activity and convert nutrients into energy through cellular respiration.
Resveratrol Resveratrol > Decrease Pro-inflammatory cytokines : TNF-a and IL-1B, increase anti-inflammatory cytokine IL-10, diminish 1kg/AL bag

p38 MAPK protein activation
> Suitable for skin-lightening products > Restore antioxdant function
> Reduce cell apoptosis/Apoptotic Levels, as protectant and detoxicant

IMPORT MATERIALS

SPEC-CHEM INDUSTRIAL INC.

Trade Name INCI Nam Properties ckage
SpecKare®BSA (Betaine salicylate) Betaine Salicylate > Natural Skin Smoothing Agent > Anti-acne & Moisturizing Agent 1kg/AL bag
. . . . . . » Broad-spectrum antimicrobial activity > Very strong sterilization »Hair conditioning agent
SpecKare® CB (Cetrimonium Bromide) Cetrimonium Bromide N . ) 1kg/AL bag
> Stability at high temperature > Wide range of pH usage
» Improves skin elasticity, firmness and radiance, suitable for stressed skin
» Provides strong UV radiation protection. > Increases the Aerobic Capacity, potent antioxidant capability
» RSV enhanced mitochondrial enzymatic activity and convert nutrients into energy through cellular respiration.
SpecKare® Resveratrol (Natural) Resveratrol » Decrease Pro-inflammatory cytokines : TNF-a and IL-1B, increase anti-inflammatory cytokine IL-10, diminish 1kg/AL bag
p38 MAPK protein activation
» Suitable for skin-lightening products > Restore antioxdant function
» Reduce cell apoptosis/Apoptotic Levels, as protectant and detoxicant
The FDA in the United States recognizes bromelain as generally safe, and has categorized it as a food additive.
» Bromelain is considered to have very low toxicity, with an LD50 greater than 10 g/kg.
. > Toxicity tests on dogs, with increasing levels of bromelain up to 750 mg/kg administered daily, showed no
Specpure® BML 60 Bromelain, Glucose . . 1kg/AL bag
toxic effects after sixmonths.
» Dosages of 1.5 g/kg/day administered to rats showed no carcinogenic or teratogenic effects.
» In human clinical tests, side effects are generally not observed.
> Inhibits the formation of melanin pigment by inhibiting Tyrosinase activity
. . . » Prevents the production of fliver spots and freckles.
SpecWhite® ABT (Arbutin) Arbutin . o o . . . . 1kg/AL bag
» The good skin whitening agent which is very popular in Japan, South Korea and ather Asian countries for skin
de-pigmentation.
Specwhite® MAP . » Stable vitamin C derivative > Prevent periodontal disease > Stimulate collagen production
Magnesium Ascorbyl Phosphate 1kg/AL bag

(Magnesium Ascorbyl Phosphate)

> Reduce hyperpigmentation > Anti-inflammatory > Maintain skin hydration > Relatively high pH tolerance

IMPORT MATERIALS

Trade Name

INCI N

Guangxi Changzhou Natural Pharmaceutical Co., Ltd

ckage




Recell Lab

» Antioxidant: Activates Nrf2, which has antioxidant and cytoprotective properties

Asiatic Acid 95% Asiatic Acid, Centella Asiatica Extract . . R ) . ) . 1kg/AL bag
> Anti-inflammatory: Reduces inflammation, including mouse ear inflammation
Asiaticoside 90% Asiaticoside, Centella Asiatica Extract » Firming Effect » Anti-Wrinkle Effect > Nourishing Effect 1kg/AL bag
. L . L » Wound Healing » Collagen Synthesis > Reduced Inflammation > Skin Health
Total Triterpanes 80% Asiaticoside, Madecassoside, Centella Asiatica Extract . K 1kg/AL bag
> Anti-oxidative Stress Reduction
Free Genins 90% Madecassic Acid, Aiatic Acid, Centella Asiatica Extract  |» Wound Healing > Anti-Inflammatory Effect » Antioxidant Activity > Moisturizing Benefits 1kg/AL bag
. . . . e » Promotes collagen production and helps the skin to heal and regenerate.
Madecassic Acid 85% Madecassic Acid, Centella Asiatica Extract X K i 1kg/AL bag
» Anti-Inflammatory > Soothing benefits
Madecasosside 80% Madecassoside, Centella Asiatica Extract 1kg/AL bag
X . . » Soothing Effect > Repairing Effect » Skin Barrier Repairing Effect > Antioxidant Effect
Madecassoside 90% Madecassoside, Centella Asiatica Extract T . A 1kg/AL bag
» Moisturizing Effect > Anti-redness (Erythema reduction)
Madecassoside 95% Madecassoside, Centella Asiatica Extract 1kg/AL bag
Asiaticoside, Madecassic Acid, Asiatic Acid, Centella » Anti-Wrinkle Properties > Firming Effects » Repairing Effects » Anti-Inflammatory Properties
TECA 95% o . . X X 1kg/AL bag
Asiatica Extract » Antioxidant Activity > Skin Health Improvement > UV Protection
Acmefleur Acmella Oleracea Extract > Natural "Plant Botox" withour injections » Immediate anti-wrinkle efficacy and anti-aging active ingredient Tkg/bottle

IMPORT MATERIALS

OTHERS

Trade Name INCI N Properties ckage
A mild anionic surfactant derived from the plant-derived amino acid L-Glutamic acid. This ingredient is available
Amisoft-LS11 Sodium Lauroyl Glutamate in powder format. It has excellent cleansing and foaming properties, and at the same time helps keeping the 15kg/square can
skin and hair moisturized.
Provides abundant foaming power and a refreshing texture.
. > Highly biodegradable and decomposes quickly during drainage.
FLDS-L Water, Sodium Lauroyl Aspartate 18kg/square can

> It has very little odor and is recommended for use in fragrance-free products.

» Suitable for shampoo, face wash, and body soap.

L-Ergothioneine Ergothioneine

» Powerful Antioxidant Power > Delaying Aging » Inhibiting Tyrosinase for SkinBrightening
» UV Aging Resistance » Anti-Inflammatory Effect

1kg/Al bag
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| Ceramide Series Products [

Powders

Trade Name INCI Name r ifficacy { Package

+ Naturally fermented, the ceramide whose structure is

closest to the skin itself, and has a strong skin affinity. .
. K . Long-lasting
« It can quickly rebuild the bond between cells and repair the

. K moisturizing, 500g/bottle
DropCare® Cera-3 Ceramide NP barrier. . 0.01-1%
) . ) ) Relieve, 10kg/barrel
- Long-lasting moisturizing and effective reduction of Repai
epair.
transepidermal water loss. P
- Quickly repairs dry skin and relieves red spots.
- Activates the second messenger of epidermal cells to Long-lasting
Ceramide NP, Ceramide promote endogenous repair. moisturizing, 500g/bottle
DropCare® Cera-NG 30 R . R . R 0.01-5%
NS/Ceramide NG - Exogenous addition of ceramides nourishes nerve synapses, Relieve, 10kg/barrel
soothes and moisturizes. Repair.
- Similar to keratin metabolism, it effectively promotes
metabolism. .
. . X . Repair, 500g/bottle
DropCare® Cera-6 Ceramide AP - Normalize the skin's natural peeling process through .. 0.001-0.5%
K X K . . Anti-aging. 10kg/barrel
molting, rejuvenating dull, rough and aging skin.
- It is especially suitable as a peeling agent for sensitive skin.
- Stimulates keratinocyte differentiation and improves the .
N A Soothing:
skin barrier.
. . . . . 0.01-0.2%,
- It has good antibacterial activity, regulates the skin Soothing, Renai
epair:
microecology, and is beneficial to the treatment of acne and Repair, P
DropCare® Phytos Phytosphingosine dandruff. Anti-acne 0.005-0.1%, So0g/bottle
ro ) -
P Wt Vtosphing . i L Anti-acne: 10kg/barrel
- Improve post-sun redness and swelling, and relieve post- Helps with 0.05-0.3%
. -U. 0
sun skin discomfort. dandruff. . ’
. . P . Hair & Scalp Care:
- Effectively relieves skin irritation and verifies the symptoms
0 0.005-0.6%.
of sensitive skin.
- Promote the metabolism of human keratinocytes and
strengthen the skin barrier. Remove dark
) ) . gt i . R 500g/bottle
DropCare® Te-Phytos | Tetraacetylphytosphingosine |- Inhibits UV-induced reduction of type I procollagen and circles, 0.001-1% 10kg/barrel
increase of MMP-1 in human dermal fibroblasts. Anti-aging. &

- Reduces dark circles and enhances eye cell vitality.

- P tes the thesis of profibrin-1 in fibroblasts.
romotes the synthesis ol pro. rin-11n roblasts. Repairofthe skin

- Effectively repairs photoaging skin and reduces the 500g/bottle
DropCare® Sal-Phytos | Salicyloyl Phytosphingosine IVey rep K P eing ! after the sun, 0.05-0.2% of
appearance of wrinkles. Anti-ain 10kg/barrel
- Smooths skin and strengthens the skin barrier. gine:
- Ceramide with long molecular chains, is a lipid component Long-lasting S00g/battle
DropCare® Cera-9 Ceramide EOP of the skin. moisturizing, 0.000001-0.08% 10kz/b )
arrel
- Stabilize the skin lipid structure and repair the skin barrier. Repair
+ The component of intercellular lipids in the stratum
corneum of skin. .
X X . Long-lasting
. - Accelerate the epidermal renewal cycle, build an efficient L. 500g/battle
DropCare® Cera-5 Ceramide AS . ) moisturizing, 0.00001-0.3%
water barrier outside the stratum corneum. Repai 10kg/barrel
epair
- Prevents moisture from evaporating and is ideal for P
repairing sensitive and dry skin.
- The component of intercellular lipids in the stratum
corneum of skin. Long-lastin,
. A . A . . s L. 6 500g/battle
DropCare® Cera NG Ceramide NS/Ceramide NG |- It quickly penetrates into the intercellular space, deeply moisturizing, 0.001-2% 10kg/barrel
arrel
nourishes, stabilizes and reestablishes intercellular Repair

connections, and instantly repairs dry and damaged skin.

SAFETY

BEAUTY

AEETY
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TradeName

INCI Name

Properties

RECR - GREE
Little by little - Make the future

Efficacy

Dosage Package

DropCare® Cera-Oil 50

Ceramide NP,
Tetraacetylphytosphingosine,
Polyglyceryl -2 Isostearate,
Sorbitan Oleate, Glyceryl
Stearates, Butyloctanol, 1,2-
Hexanediol

- Can be applied to eye anti-aging products.
- Good oil solubility, it is recommended to mix oils:

squalane, GTCC, IPM, 2EHP, vegetable oil, etc.

- Exogenous ceramide supplement, immediate repair of

cuticle brick wall structure.

Long-lasting
moisturizing,
Relieve,

Repair.

1kg/bottle
25kg/bucket

0.01-5%

Aqueous

Trade Name INCI Name Package
- The ingredients are streamlined, non-ionic, safe and non-
irritating.
Ceramide NP, Hydrogenated g. i X Long-lasting
. « It can quickly rebuild the bond between cells and repair the A ..
Lecithin, Polyglyceryl- K moisturizing, 1kg/bottle
DropCare® Cera-3L(5%) barrier. . 0.2-5%
10 Laurate, ) . . ) Relieve, 25kg/bucket
. - Long-lasting moisturizing and effective reduction of .
Dipropylene Glycol . Repair.
transepidermal water loss.
- Quickly repairs dry skin and relieves red spots.
Ceramide NS/Ceramide NG,
Ceramide NP, Ceramide AP, |- Micro-emulsification technology is used to compound L lasti
ong-lastin,
Ceramide EOP, multiple ceramides to achieve better synergistic effects. . N . s
L A A L moisturizing, 1kg/bottle
DropCare® Bionic 100 | Aqua, Butylene Glycol, Hydr |- It solves the problem of difficult dissolution in the formula . 0.01-5%
- X R K Relieve, 25kg/bucket
ogenated Lecithin, and is easy to use in various systems. Repair
Polyglyceryl- - Itis not ionic and can be applied to the carbo system. patr
10 Laurate, Pentylene Glycol
. . - Micro-emulsification technology is used to compound
Ceramide NP, Ceramide ) A A . .
R . multiple ceramides to achieve better synergistic effects. Long-lasting
NS/Ceramide NG, Ceramide i . o R
L ) - It solves the problem of difficult dissolution in the formula moisturizing, 1kg/bottle
DropCare® Bionic 70A AP, Salicyloyl K R R i 0.01-10%
. i and is easy to use in various systems. Relieve, 25kg/bucket
Phytosphingosine, . . )
X i - The water solubility is very good, and it is clear and Repair.
Phytosphingosine, etc. ; i
transparent after dissolving.
- Micro-emulsification technology is used to compound
. . multiple ceramides to achieve better synergistic effects. Long-lasting
Ceramide NP, Ceramide AP, i . L .
L . A ) - It solves the problem of difficult dissolution in the formula moisturizing, 1kg/bottle
DropCare® Bionic 90A [ Salicyloyl Phytosphingosine, X R K i 0.01-10%
. i and is easy to use in various systems. Relieve, 25kg/bucket
Phytosphingosine ,etc. . . X
- The water solubility is very good, and it is clear and Repair.
transparent after dissolving.
- A powder compound of ceramide NP that can be dispersed
Ceramide NP, Hydrogenated | in water. Long-lasting Ikg/ba
DropCare® Cera-3 30P Lecithin, Glyceryl Stearate, |- Micro-emulsification technology is used to compound moisturizing, 0.01-10% Skzb &
2
Dipropylene Glycol multiple ceramides to achieve better synergistic effects. Repair &
- The ingredients are simple and easy to use.
Long lasti
Ceramide NP, Ceramide AP, O?g a45 Tng
L ) moisturizing, 1kg/bottle
DropCare® Bionic 150 Ceramide EOP, . i 0.01-5%
i . repair the barrier, 25kg/bucket
Phytosphingosine ,etc. i
- The combination of multiple ceramides with relieve.
Ceramide NP, Ceramide AP, | microemulsification technology can achieve better Long lasting
L Ceramide EOP, Ceramide NS| synergistic effect. moisturizing, 1kg/bottle
DropCare® Bionic 150 Pro . . L . ) . 0.01-5%
/ Ceramide NG, Ceramide |- It solves the problem that it is difficult to dissolve in the repair the 25kg/bucket
AS, Phytosphingosine ,etc. | formula and is easy to use in various formulas. barrier, relieve.
Ceramide NP, - The product is ionic, and the carbomer system is not X
i Long lasting
Ceramide AP, recommended. e
L i moisturizing, 1kg/bottle
DropCare® Bionic 150 H Ceramide EOP, ) ! 0.01-5%
Phytosphingosine repair the barrier, 25kg/bucket
ytosphing ’ relieve.
etc.
Ceramide NP, Hydrogenated Long lastin,
? y 8 - The first three-cavity dispersion nano emulsion, the . s . g
DropCare® Nano Lecithin, . A . . moisturizing, 1kg/bottle
i product is more stable, improve the efficacy and skin feeling. ) i 0.01-10%
Cera-3L (1%) Aqua, Glycerin, . L repair the barrier, Skg/bottle
- water dispersion is good, can be cold, opaque. i
Hexyldecanol relieve.
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Whitening & Anti—Spot

INCI Name

Properties

- Prodrug of cysteine (amino acid), natural source, safe and
skin-friendly.

RECR - GREE
Little by little - Make the future

Efficacy

Dosage

Daily use: 0.5-2%,

Package

. L Oxothiazolidinecarboxylic |- Increases intracellular glutathione content by providing the Whitening, . 1kg/bag
DropBrigt® Litein Acid . R R L. Specific purpose:
substrate cysteine for glutathione synthesis. Antioxidant. 2.0%-5.0% 25kg/barrel
. 0-9. 0.
- Excellent whitening & brightening effect.
- It is water-soluble and easy to use.
- High purity, high quality, good safety ‘Whitening,
DropBrigt® HEPES Hydroxyethylpi.peraz.ine . Pr.omote.cutin metabolism, gently exfoliate, without Exfoliatm.r, 0.5:2% 1 kg/bag
Ethane Sulfonic Acid stimulation. Smooth skin, 25kg/barrel
- Promote smooth and bright skin stabilize pH.
Hyds i 1 1 kg/barrel
DropBrigt® HPR P ydroxypinacoione ) ) o 0.05-0.3% gfbarre
Retinoate - Third generation VA derivative, more safer. Spot-fadi 25kg/barrel
" . . . pot-Tading,
Hyd 1 - Less stimulat; fficient.
. Vi rox;fpmaco one ess s.lmu ating, more e c1en. . anti wrinkle. 1 kebag
DropBrigt® HPR L Retinoate, - Effectively reduce age spots, wrinkles, reduce peeling. 0.5-3% 25kg/barrel
arrel
Dimethyl Isosorbide
- Good water solubility, more diverse formulas, note that it
cannot be compounded with carbomer,sodium hyaluronate, ‘Whitening, Daily use:
di lyglutamats th: te., and b t-fading, Tender| 0.1-0.5%), Specifi 1kg/b
DropCare® PPN60 Papain so. ium po y.g utamate, xanthan gum, etc., and can be spot-fa 1r?g, ‘ender 6, Specific g/bag
thickened with hydroxyethyl cellulose. skin, purpose: 25kg/barrel
- Gentle exfoliation, whitening skin. Bright white teeth. 0.5-3%.
- Natural plant extract, safe and non-irritating.
- Found in natural products, more safer.
+ It has both phenolic hydroxy-OH and alkene bonds in Whitening,
structure, showing strong oxidation resistance. Antioxidant 1 kg/ba
DropBrigt® FLA Ferulic Acid ure, wing rA g. Xt . ! g . ! x14 ’ 0.1-0.5% e/bag
+ It can enhance the anti-oxidative stress effect of skin and Anti- 25kg/barrel
play a positive role in preventing photoaging and skin inflammatory.
photodamage.
+ A stable vitamin C derivative that promotes skin collagen Daily use:
synthesis. Whitenin, 0.5-5% 1 kg/ba
DropBrigt® SAP Sodium ascorbate phosphate yn ! . ) Al A 108, . " e/bag
- Suitable for high concentration formula. Antioxidant. Specific purpose: 25kg/barrel
- It has good water solubility and high bioavailability. 10-20%
- Stable vitamin C derivatives to protect skin and reduce light
DropBrigt® MAP Magnesium da?‘nage. . ) W}.1itevning, 1.0-3.0% 1 kg/bag
Ascorbyl Phosphate - Suitable for high concentration formula. Antioxidant. 25kg/barrel
- It has good water solubility and high bioavailability.
+ A stable vitamin C derivative.
- It is produced by enzymatic method (based on fermentation
rocess), which has good selectivity, efficienc Whitenin, 1 kg/ba
DropBrigt® AA2G Ascorbyl Glucoside p, _)’ L 8 . v, e . S 0.5-2% g/bag
bioavailability, bioactivity and low cost. Antioxidant. 25kg/barrel
- Glucose is introduced to give it extra properties as better
solubility and moisture retention.
- Possess the structure of lipophilic and hydrophilic.
- Excellent stability of light, heat, acid, alkali, salt and Whiteni 1kg/b:
DropBrigt® VCE 3-0-Ethyl Ascorbic Acid cellent stability of light, heat, acid, alkali, salt an _l e?lng, 1.0-3.0% g/bag
oxygen. Antioxidant. 25kg/barrel
- Strong antioxidation, eliminate the free radical in body.
) ' . Highly—effec'tive skin .lightening agent, Bleaching agent. Whitening, Ikg/bag
DropBrigt® AAB Alpha-Arbutin - No hydroquinone residue. . 0.1-2.0%
X i R A Anti-spot. 25kg/barrel
- Biological enzyme engineering products.
- Compliance with BP2017 standard. ‘Whitening,
DropBrigt® TAA Tranexamic Acid - Tranexamic acid is suitable to all kinds of skin for removing Anti-spot, 0.5-2.0% 25kg/barrel
pigmentation, whitening skin and reducing spots. Hemostatic.
- High safe and light stable, no irritation.
) . ) . Inhibiti.on of tyrosif]ase acti\iity to d.ese'ilinate melanin. Whitening, Ikg/bag
DropBrigt® 4MSK Potassium Methoxysalicylate - Regulation of keratinocyte differentiation can smooth the i 0.1-0.5%
h Anti-spot. 25kg/barrel
skin.
- Water-soluble whitening agent, easy to use.
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I Moisturizing & Repairing [

RECR - GREE
Little by little - Make the future

Trade Name INCI Name Package
Glutamylamidoethyl
. Imidazole, Water,
DropPet® Period ONE 0.5-2%
Phenoxyethanol,
Sorbic Acid.
Glutamylamidoethyl - Effective activation of the rhythm gene Period ONE.
DropPet® Period ONE Imidazole, Aqua, Glycerin, |- Day and night repair, adjust the skin condition. Night repair, Anti- 0.5-10% 1kg/bag
Lo~ 0
(0.1%) Caprylyl Glycol, - Optimize skin physiological defense and activate cell wrinkle. 25kg/barrel
Ethylhexylglycerin regeneration.
Glutamylamidoethyl
Imidazole, Aqua, Glycerin
DropPet® GIL (1%) PF » £qua, By ’ 0.5-2%
Caprylyl Glycol,
Ethylhexylglycerin
. . 0il control,
- Derived from natural fermentation of lactose. B
ne pore
L ) - Polyhydroxy bionic acid multi-effect repair. ! K p ’
DropCare® LA Lactobionic Acid ) ) . ) . Antioxidant, 0.5-10.0% 25kg/barrel
- The third generation of fruit acid, gently exfoliate cutin, .
. . . . Moisturize,
repair and moisturize the skin. L
Anti-aging.
+ An amino acid derivative derived from biological .
R Long-lasting
fermentation. i
High intracellular tolerance, good thermostability and hydrating, Sun
- Hi;
g o 8 Y block, Anti-blue-
. hydrophilic. . 1kg/bag
DropCare® ECT Ectoine . . L. . A ray, Anti & 0.2-3.0%
- Protect cells, hair follicle anti-aging, anti & alleviate . 25kg/barrel
infl N alleviate
m .an.lma ory: X inflammator,
- Inhibits protein' carbonylation, promotes collagen'
) Restore.
synthesis.
Daily moisturizing
- Its three-dimensional structure forms an invisible care products:
N breathable protective film to resist external pollution and . .. 0.5-3%,
. Bacillus/Soybean Ferment A | Moisturizing, i
DropBio® stimulation. ) o Facial masks &
A Extract, Butylene Glycol, A . . . . . Repair, Inhibits A 25kg/barrel
3D Lubrigel . - Quick repair of skin barrier, long-term moisturizing. . . repair products:
Aqua, 1,2-Hexanediol. i . cicatrices.
- Its superlarge molecules can effectively inhibit scar 3-5%,
formation. Hair care and
scalp care: 0.5-5%.
- It helps the wound heal. L.
- It can help strengthen and repair barrier protection. Antl-aging,
P R P . P . ) Anti-wrinkle,
. - It can help reduce wrinkles and improve skin smoothness. . 1kg/bag
DropCare® ATP Adenosine . . Anti- 0.5-4%
« It can help prevent hair loss and help hair growth and . 25kg/barrel
N henin inflammatory,
ren 3
strengt & Prevent hair loss.
- It can help boost cellular energy.
) - Effectively inhibits inflammatory factors, soothes skin 10g/bottle
DropCare® VB12 Cyanocobalamin R . R ) ) 0.0005-0.01%
discomfort and reduces inflammation. Moisturize, 100g/bag
- Vitamin B12 is involved in protein synthesis and smooths Repair,
DropCare® VB12 (0.1%) Cyanocobalamin, the skin and reduces the appearance of fine lines. Anti- 0.05-10% 5kg/bag
Maltodextrin, - Protects damaged skin against UV damage and helps skin inflammatory.
DropCare® VB12 (1%) Sodium Citrate, Citric Acid | repair quickly. 0.005-1% Skg/bag
BEAUTY
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Natural fermentation

Trade Name

INCI Name

Saccharomyces/Xylinum/Bla

Properties

- Combination of natural tea polyphenols and probiotics, 72

hours probiotics pure, deep compound fermentation.

RECR - GREE
Little by little - Make the future

Antioxidant,

Dosage

Package

DropBotatur® BTF . . . Repair, Lighten 0.5-10% 25kg/bucket
ck Tea Ferment - Improve the facial microenvironment Ki
skin.
- Outstanding antioxidant capacity, improve skin immunity.
Daily moisturizing
conditioning:
. . 0.5-3%,
- Made by natural yeast galactose-like fermentation and L ) i
, . . . . . Whitening, Anti- | Acne skin care:
Galactomyces Ferment extraction, it improves skin quality and brightens skin tone. X
DropCare® GA h . L. acne, Anti- 3-5%, 25kg/bucket
Filtrate - Promote renewal, repair and anti-aging. K X i
. ) R . wrinkle. Lighten skin:
- Anti-inflammation, oil control,anti- pox.
5-10%,
Anti-aging:
10-30%.
Glycolipids, Aqua, 1,2~ | It can play the role of dispersion, wetting, water retention,
DropBio® Soph L Hexanediol, lubrication and emulsification, and is a mild surfactant.
Ethylhexylglycerin - It has a milder bactericidal effect and can effectively inhibit Emulsify
mulsi
P. acnes and Corynebacterium lactis. ’
. . Clean, 0.5-5% 25kg/bucket
- It has anti-inflammatory activity and reduces the release of . .
Antibacterial.

DropBio® Soph L 50

Glycolipids, Aqua

inflammatory cytokines.

- It can inhibit the activity of lipase and prevent the

breakdown of sebum and the production of free fatty acids.

Beauty Peptide

Trade Name

INCI Name

Properties

Dosage

Package

- Potent double resistant peptide, antioxidant, anti-glycation. Antioxidant, 1kg/bag
DropPet® LC Carnosine + Protective proteins prevent oxidative stress damage. Antioxidant, 0.1-2% Skg/bag
- Radiant Resilience. Tightness. 15kg/bag
- It's a kind of neurotransmitters inhibiting peptide that
inhibiting the synthesis of SNARE receptor.
6 the synthesis of % P! ) o 10g/bottle
. - It can smooth dynamic, static and fine lines, also it can Anti-wrinkle,
DropPet® AHP8P Acetyl Hexapeptide-8 ) A . . . 0.005-0.05% 100g/bottle
effectively recombine collagen' elasticity and increases the Anti-aging. s00g/bottl
ottle
activity of elastic protein. &
- It's a very reliable safe alternative of Botulinum Toxin.
+ A neurotransmitters inhibiting peptide.
- A reversible antagonist agent for muscle nicotinic
acetylcholine receptor (mnAChR).
- Blocks the transmission of nerve signals on acetylcholine 10g/bottle
Dipeptide Diaminobutyroyl . s . X ] Anti-wrinkle, e/
DropPet® DKEP . . receptors, so as to relax false wrinkles in a timely and long- .. 0.005-0.5% 100g/bottle
Benzylamide Diacetate i Anti-aging.
lasting manner. 500g/bottle
- Simulates waglerin-1' activity, which is a peptide found in
the venom of tropidolaemus wagleri.
- Especially suitable for local care of smoothing facial lines.
« It can inhibit the permeability of capillaries and reduce the
water accumulation of eye bags.
- It inhibits the activity of ACE enzyme, it means that so that | Eye-bags removal, 10g/bottle
DropPet® ATP5P Acetyl Tetrapeptide-5 it can cope with eye bags by improving blood circulation Edema removal, 0.005-0.05% 100g/bottle
through the antihypertensive effect. Anti-wrinkle. 500g/bottle
« It can be used to indirectly inhibit the formation of eye bags
as working as a glycosylation inhibitor.
- It is a small molecule active peptide with good transdermal
absorption effect.
P i L 10g/bottle
R - It can promote the gene expression of type I collagen and Antioxidant,
DropPet® TR-1P Tetrapeptide-1 . 0.00001-0.001% 100g/bottle
type I1I collagen. Anti-aging.
500g/bottle

- It can effectively remove wrinkles and improve skin

elasticity.
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Little by little - Make the future

TradeName Name Properties Efficacy Dosage Package
- Good solubility, it's suitable for various systems.
Acetyl hexapeptide-8, iy, R vart Y L Suppressed
. . - It can help reducing the amount of expression lines, X 1kg/bottle
Palmitoyl Pentapeptide-4, R N R expression
DropPet® AgeS . prominent nasolabial folds, forehead wrinkles, crow's-feets, 1-5% Skg/barrel
Glycerin, Aqua, 1,2- . X i pattern, Fade
. and so more other existed wrinkles by multiple effects. . 25kg/barrel
Hexanediol. i B} L ) wrinkles.
- Without any preservatives, it is suitable for mild formulas.
- It can assist smoothing wrinkles in a short time. Quick-acting 10g/botl
ottle
L. . . .| It can smooth the expression lines without paralyzing the expression print,
DropPet® ALP Arginine/Lysine Polypeptide R i . o i 5-200ppm 100g/bottle
muscle. Don't worry about the lines, just smile. Firming skin, 500g/bottl
ottle
- It is mild, non-irritating, stable and easy to use. Reduce wrinkles.
- Oligopeptide-1 is one kind of signal peptide, which can
inhibit the carbonylating of collage. .
Tripeptide-1, Glyceri It stimulates the production of ECM proteins (collagen I Daily care: Ikg/bottl
ripeptide- cerin, - It stimulates the production o roteins (collagen ottle
Pep » O i p . .p. . 8 Anti-wrinkle, | 0.5-2%, Advanced ¢
DropPet® GHK1 (0.1%) Trehalose, Caprylyl Glycol, | and III, fibronectin, elastin and laminin), thus tightens the Restorati Skg/barrel
estoration. care:
Ethylhexylglycerin, Aqua skin and promotes the renewal and healing of skin tissues. 2-5% 25kg/barrel
=270,
- Effectively reduces the amount of wrinkles, acnes and
wounds, smooth the skin.
Acetyl Tetrapeptide-5.
Pal 'ty 1P f iy tided Daily care: Tkg/bottl
almitoyl Pentapeptide- ottle
Y pep | It helps to reduce the edema and tighten the skin around Eye tightness, 1-3%, ¢
DropPet® APA Aqua, Acetyl Hexapeptide-8, X Skg/barrel
eye-side. Edema removal. | Advanced care:
Polysorbate 20, 350 25kg/barrel
-070.
1,2-Hexydicol
Acetyl Hexapeptide-8,
Pal 'ty 1 PX f P tid ’4 - Promotes the production of collagen. Dail .
& ml' oy fertapep 1 €% | Inhibits expression lines' forming, smooth fine lines L. atly care: 1kg/bottle
Palmitoyl Tetrapeptide-7, . Anti-wrinkle, 1-3%,
DropPet® P650 A quickly. Ticht Ad d Skg/barrel
ua, ightness. vanced care:
e, - Smooth wrinkles in different skin texture levels, firming 8 25kg/barrel
Phenoxyethanol, . . 3-5%.
. skin, makes it younger.
Ehylhexylglycerin.
. - Effectively decrease the numbers of the wrinkles around
Acetyl Tetrapeptide-5, Eye-bags removal,
. . eyes. 1kg/bottle
i Sclerotium extract of poria i Edema removal,
DropPet® Eyelid T - Effectively reduce the eye edema and eye bags caused by L. . 2-5% Skg/barrel
cocos, Butylene Glycol, X R Firming, Anti-
_ . tiredness and aging. . 25kg/barrel
Aqua, Dipeptide-2. K . . ) wrinkle.
- Firm and increase the elasticity of the skin.
Palmitoyl tripeptide-1, + Promotes the production of collagen; Anti-wrinkle 1kg/bottle
-wri
DropPet® M3000 Palmitoyl tetrapeptide-7, |- Effectively smooth prominent nasolabial folds, forehead Tieht ! 3-10% Skg/barrel
ightness.
water, Glycol. wrinkles, and other kind of deep skin lines. & 25kg/barrel
Palmitoyl Tripeptide-1,
¥ Pripep i |- Reduce lip wrinkles and moisturize your lips. 1kg/bottle
. Ethylhexyl Palmitate, . . . . . .
DropPet® LipS Hot K i i + Promote lip blood circulation, heat sense is obvious. Lip plump. 0.5-3% Skg/barrel
Tribehenin, Sorbitan . . . .
i - Enrich and moisturize your lips to make them fuller. 25kg/barrel
Stearate, Vanillyl Butyl Ether
- A variety of active peptides promote the production of
. collagen, elastin, polysaccharides and other substances
Glycerin, Aqua, Polysorbate . A
K . secreted by fibroblasts from multiple pathways and different
20, Tripeptide-1, tareet
argets.
Hexapeptide-9, Palmitoyl g i ) . Firming skin, 1kg/bottle
. R ) - Maintain the structure of the dermis, repair the basement L
DropPet® ElaS Tripeptide-1, Palmitoyl . i Anti-wrinkle, 0.1-5% Skg/barrel
. ) . membrane, and promote keratin synthesis and enhance the .
Tripeptide-5, Palmitoyl A . . . Repair. 25kg/barrel
K . regeneration ability of the epidermis.
Tetrapeptide-7, Palmitoyl K L . o i
. - Intensely repairs the skin, improves skin quality (including
Pentapeptide-4 X .
roughness, firmness, softness, etc.), and long-lasting anti-
aging.
- Multi-channel improves the production of melanin in the
Aqua, Pentylene Glycol skin, removes the dull yellow caused by glycation, and
qva, R y 4 J ’ . v . Y B! ’ Skin whitening, 1kg/bottle
1, 2-Hexadiol, Nonapeptide- | makes the skin supple and fair. ..
DropPet® Crystal ) . R ) R Antioxidant, 0.1-5% Skg/barrel
1, Decarboxy Carnosine |- Prevents gene expression during melanin formation and . .
. i Anti-glycosylation. 25kg/barrel
HCL. reduces melanin production.
- It can scavenge free radicals and resist glycation reactions.
BEAUTY
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B Acne Care & Oil Control [

Trade Name

INCI Name

Properties

RECR - GREE
Little by little - Make the future

Dosage

Package

DropCare® AZE

Azelaic Acid

- An effective tyrosinase inhibitors.
- It is gentle to exfoliate so as to prevent hyperkeratosis of

hair follicles. Also it can prevent and suppress whiteheads
and blackheads.

- Inhibits the proliferation of abnormal melanocytes and

melanoma cells.

- Effectively reduces the occurrence of skin pigmentation,

also works well at improving them.

0il Control,
Acne Care,
Brightening.

Daily Care:1-5%,
Advance Care: 5-

10%, Special Care:

15-20%.

1kg/bag
25kg/barrel

DropCare® QA-73

Quaternium-73

+ Advanced sterilization, can be synergistic anti-corrosion.

- Effectively inhibits Propionibacterium Acnes and removes

acnes.

+ Advanced inhibition of melanin formation, effectively

removes pockmarks.

Acne & Acne Scar

Removal.

0.001-0.005%

1kg/bag
25kg/barrel

DropCare® SA

Salicylic Acid

- Small molecule acid with strong osmotic force.

- Improves the phenomenon of pigment deposition and

photoaging.

0il Control, Acne
Care.

0.1-2.0%

1kg/bag
25kg/barrel

DropCare® 3D-SA

Salicylic Acid, Acacia
Senegal Gum

- Exfoliates, removes blackheads, shrinks pores and reduces

sebum secretion.

- Non-irritating, safe and burden-free to the skin.
- Water-soluble, making it easy to add to different

formulations.

0il Control, Acne

Care.

0.5-4%

1kg/bag
25kg/barrel

DropBotatur® Salix

Salix Alba (Willow) Bark
Extract

- Natural source, extracted from the bark of the white willow

tree, also known as "natural salicylic acid".

- White willow bark has similar properties to salicylic acid

and acetylsalicylic acid, which inhibits P. acnes, is less
irritating and milder.

+ Removes acne scars and improves skin "acne skin"

problems.

0il Control, Acne
Care.

0.1-2%

1kg/bag
25kg/barrel

DropCare® AZE 60

Azelaic Acid,
Hydroxypropyl
Cyclodextrin, Methyl
Cyclodextrin, Acacia
Senegal Gum,
Maltodextrin, Disodium

- An effective tyrosinase inhibitors.
- It is gentle to exfoliate so as to prevent hyperkeratosisof

hair follicles. Also it can prevent and suppress whiteheads
and blackheads.

0il control, ance

care, brightening

1-20%

1kg/bag
25kg/barrel

AL 1|
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Hair & Scalp Care

Trade Name

INCI Name

Properties

RECR - GREE
Little by little - Make the future

Dosage Package

Anti-dandruff
shampoo:
0.2-0.8%,
- Effectively inhibits Malassezia. Anti-dandruff
- Antidandruff, anti-pruritic, anti-inflammatory and remove | Anti-dandruff, conditioner:
acne. Anti-pruritic, Anti- 0.1-0.3%
DropCare® OCT Piroctone Olamine i oL A P ’ ” 25kg/barrel
- Safe, mild, and non-irritating. inflammation, Shower gel:
- Can be used in transparent formulations without Anti-septic. 0.2-0.5%,
suspensions. Preservative:
0.2-0.5%,
Deodorant:
0.2-0.5%.
Antidandruff:
Anti-dandruff, !
: . . - . . 0.2-0.5%
- Excellent antifungal effect, anti-dandruff, and anti-pruritic. Anti-pruritic, Oral C
DropCare® DA24 Dichlorobenzyl Alcohol |- Antihistamine and anti-inflammatory. Antiseptic, Broad- o (r; o :::/' 25kg/barrel
- Mild, with good compatibility. spectrum e . ’
. Preservative:
sterilization.
0.05-0.15%
+ Similar in structure to minoxidil, both are effective anti-
germinal agents. Anti-defixation:
DronCare® PDO Pyrrolidinyl + By improving the blood circulation on the skin surface, it | Thread-off proof, 0.5-2%, 1 kg/bag
T T
P Diaminopyrimidine Oxide | provides the required nutrition for the hair root, thus Hair growth. Potent dosage: 25kg/barrel
achieving the effect of inhibiting hair shedding and 2-5%.
promoting hair growth.
- It contributes to the maintenance of extracellular matrices
such as collagen IV and laminin V, and stimulates the
L. . . synthesis and stabilization of ECM proteins such as collagen
Biotinoyl Tripeptide-1, .
L. . A IV and laminin 5.
Apigenin, Oleanolic Acid, i . . . 1kg/bottle
+ Delay the aging of hair follicles, improve the structure of .
DropPet® H Growth Butylene Glycol, Aqua, PEG- | . . . . Hair growth. 0.1-3% Skg/barrel
hair follicles, fix hair in dermal hair follicles, and promote
26-Buteth-26, PEG-40 . L K . 25kg/barrel
) the fixation of hair in dermal hair follicles.
Hydrogenated Castor Oil . K K K i X
- Biotinoyl Tripeptide-1 also activates tissue repair gene
expression, promotes cell proliferation and differentiation,
and stimulates hair growth.
Acetyl Tetrapeptide-3, - It can accelerate the formation of outer matrix (ECM) Tkg/bottl
ottle
Trifolium Pratense (Clover) | proteins, such as cohesin, collagen III and VII, etc., thereby N
DropPet® H Grow02 ) K X . ] Hair growth. 0.1-3% Skg/barrel
Flower Extract, Dextran, effectively improving the structure of hair follicles and 25ke/barrel
arrel
Butylene Glycol, Aqua improving hair loss.
- New biocides.
L. . . A . . Anti-dandruff, skg/bag
DropCare® HMD Hexamidine Diisethionate |- Broad-spectrum antibacterial properties, strong inhibition . 0.036-0.1%
. L X . Hair care. 25kg/barrel
and killing ability against Malassezia.
BEAUTY
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Hydrolyzed Protein

TradeName

INCI Nan

RECR - GREE
Little by little - Make the future

Dosage

Package

- Collagen hydrolysate, small molecular weight, easy to
absorb, effectively repair skin damage. Tightness, ske/b
af
DropCare® CP Hydrolyzed Collagen - Promote collagen synthesis, enhance skin firmness and Hair care, 0.5-3% 10kgg/b &
af
elasticity. Repair. &
- Repair damaged hair, reduce hair split and rough.
- Natural grain small molecule protein, safe and non-
irritating; Natural grain small molecule protein, safe and
non-irritating. Moisturize, skeb
af
DropCare® HWP Hydrolyzed Wheat Protein |- Rich in VE, VB1, small molecule amino acids, etc., long Hair care, 0.1-1% 10k /bag
lasting moisturizing skin. Anti-wrinkle. &bag
- With positive charge, it can absorb hair surface, reduce
static electricity, enhance carding and gloss.
- Keratin hydrolysate, rich in micromolecule peptides, eas 1kg/ba;
DropCare® Hydr KP Hydrolyzed Keratin 1y . ysale, . ! Al ) ule peptices, easy . . 0.1-1% g/bag
to absorb, improve skin elasticity. Moisturize, 25kg/bucket
Hydrolyzed Keratin, Aqua, |- Enhance cuticle moisture retention. Hair care, Tkg/bottl
ottle
DropCare® Hydr KPL(PF) | Butylene Glycol, Caprylyl |- Repair perm and dye hair, increase the content of cysteine Anti-wrinkle. 0.5-5% 25ke/bucket
ucke
Glycol, Ethylhexylglycerin | in hair, increase gloss. &
Hydrolyzed Elastin, Aqua, Moisturize
¥ . yz ) ! § |, Effectively increase skin flexibility, improve skin elasticity. lA urze, 1kg/bottle
DropCare® Hydr EL Citric Acid, Sodium ) ) ) . Hair care, 1-10%
- Repair hair for silky shine. L 25kg/bucket
Benzoate Anti-wrinkle.
- Silk contains a variety of amino acids and proteins, which
Hydrolyzed Silk, Aqua, v ¥ i .p » W o
L. . . are better absorbed by skin after hydrolysis. Moisturize, 1kg/bottle
DropCare® Hydr HS Citric Acid, Sodium i ) ) L 0.5-5%
B X - Promote the secretion of collagen, enhance skin tension Anti-wrinkle 25kg/bucket
enzoate.
and elasticity.
- Rich in a variety of amino acids, trace elements, vitamins, . .
" Moisturize,
etc.
DropCare® Pearl H Hydrolyzed Pearl . . . o Anti-wrinkle, 0.5-5% 25kg/bucket
- Inhibit the activity of tyrosinase, whitening and fade spots. Whiteni
itening.
- Increase skin elasticity and reduce wrinkles. i

Plant/Herbal Extract

adeName

Package

. . |- Panax Ginseng Extract is against with aging andwrinkles.
Panax Ginseng Extract, Poria . ) A )
. - Poria Cocos Sclerotium Extract hydrate and tighten skin.
Cocos Sclerotium Extract, . . . . .
R R + Carthamus Tinctorius Extract improves skin metabolic L. 1kg/bottle
. Glycyrrhiza Uralensis Root Anti-wrinkle,
DropBotatur® Ginseng S cycle. X . 3-5% Skg/barrel
Extract, Carthamus . . Brightening.
. i + Glycyrrhiza Uralensis Root Extract as the emperor and 25kg/barrel
Tinctorius Extract, Butylene - . i . )
Glveol minister of traditional Chinese medicine can maketheactive|
co
v ingredients better absorbed by the skin.
- Invention patent technology products.
Phyllacantha Fibrosa - Contains a combination of patented custom molecular
Extract, Trifolium Pratense | weight technology brown algae extract and red clover extract]
(Clover) Extract, rich in plant isoflavones to effectively fight skin problems Lighten and firm 1 kg/bottle
DropBotatur® Algae S Hydroxypropyl caused by aging and brighten the complexion. the skin, 0.1-2% 5 kg/barrel
Cyclodextrin, Aqua, + The expression of collagen COL1 and elastin genes was Anti-aging. 25 kg/barrel
Glycerin, Caprylyl Glycol, | significantly up-regulated, and the expression of collagen-
Ethylhexylglycerin delyssing enzyme MMP1 gene was down-regulated.
- Promotes hyaluronic acid and type III collagen production.
- Invention patent technology products.
Phyllacantha Fibrosa - Effective anti-aging and moisturizing. Firmin, 1 kg/bottle
DropBotatur® Algae Y . . Eine L. & A .g, 0.5-3% 8
Extract, Maltodextrin. - The index of natural origin is 1. Anti-aging. 25 kg/barrel
- Good water solubility and good compatibility.
DropCare® Bamboo C3 - Natural, safe and environmentally friendly. Comes from
moso bamboo high temperature charcoal burning and then Cleaning,
s 1kg/ba;
DropCare® Bamboo C02 Charcoal Powder pulverizing. Coloring, 0.5-5% " e/bag .
- Replace microplastic particles. Protect ecological balance. Grinding 25kg/barre
DropCare® Bamboo C60 - Unique multi-aperture physical structure. Adsorb oil, odor,
Paeonia Suffruticosa Root .
. - Natural plant extracts, safe and low irritation.
Bark Extract, Gentiana .. . .. R . . 1kg/bottle
DropBotatur® - Anti-inflammatory, soothing, repairing skin redness and Soothing, Anti-
. Macrophylla Extract, L. . 0.1-3% 5 kg/barrel
Sensi RV P diol. Di ) irritation. inflammatory. 25 ke )
ropanediol, Dipropylene arre!
P al ’ lp Py + Water-soluble plant-based raw material for easier use.
yco!
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J Preservative

RECR - GREE
Little by little - Make the future

TradeName INCI Nam Dosage Package
Antisenti Cream and lotion:
DropPrev® N-PLG - Safe and reliable additive-free anti-corrosion. M n 1se'p '1c, 2.0%,
oisurizin,
(Natural corn cob source) - Good moisturizing and solubilizing ability. L Z_ & Water agent
mprovin;
Pentylene Glycol - Increased water resistance in sunscreen products. lpb'l'tyg product: 15kg/barrel
o . solubili
DropPreve PLG - It has a co-emulsifying function. Emulsify,] 2.5-5.0%,
. - Odorless preservative. Sunscreen:
(Synthetic source) P Assisting. L5900
Bt L 0.
Cream and
- Safe and reliable additive-free anti-corrosion. Preservative, emulsion: 2.0%,
- Good emollients, moisturizers, fixatives, water and oil Hydrating, Water agent
DropPrev® HDL 1,2-Hexanediol amphiphiles. Moisturize, product: 15kg/barrel
- Helps reduce surface tension at the oil-water interface. Fragrance 2.5-3.0%,
- Odorless preservative. Fixative. Sunscreen:
1.5-2.0%.
- An ideal organic acid inhibitor that maintains an unionized
state.
Opti bon chain length (C8) f ti Chelate, Tkg/b
- Optimum carbon chain len or promotin, af
DropPrev® CHA Caprylhydroxamic Acid P . gt P s Antimycotic , 0.05-0.15% N
degradation of cell membrane structures. Antisenti 25kg/barrel
ntiseptic.
- Chelate iron ions selectively; an inhibitor of mycotic P
growth.
1kg/ba
DropPrev® MPB o-Cymen-5-ol 0.01-0.1% g/bag
. . 25kg/barrel
C S - Accord with the standard of Japanese Pharmacopeia. Antisenti
© yme.n + Good bactericidal properties for dental plaque. n 15¢P 1'c, 1kg/bottle
ol,Isopentyldiol, PEG-40 . Antibacterial.
DropPrev® MPB10 X - Safe and reliable. 0.1-1% Skg/barrel
hydrogenated castor oil,
25kg/barrel
PPG-26-buteth-26
- Anew mild non-irritating preservative, antiseptic in a
broad spectrum. . )
. ) . Antiseptic,
DropPrev® HAP Hydroxyacetophenone |- Anti-oxidative, alleviate and soothe function. Anti-oxidant 0.1-0.5% 25kg/barrel
i-oxi .
- pH value:4-8, stable below 80°C.
- Suitable for formulations without additives.
Collaborative
- Moisturize and hydrate, improve use feeling. Preservation,
DropPrev® EHG Ethylhexylglycerin - Traditional synergistic agent for preservatives. Moisturize, 0.3-1.0% 25kg/barrel
- Promotes and fixes the fragrance of essence. Fixes the
fragrance.
- Board-spectrum anti-bacterial mild preservative without no Preservative
additive; Moisturize, synergist:
DropPrev® CPG Caprylyl Glycol + Compatible with most ingredients, PH value use range is Preservative, 0.2-0.5%, 25kg/barrel
wide; Hydrating. Moisturizer:
- Excellent moisturizing effects. 0.5-10%.
+ Broad-spectrum antibacterial.
Caprylhydroxamic Acid, . p. . i i
. - Mild, no irritation, no fever. Antiseptic,
DropPrev® CHL 02 1,2-hexanediol, o K . 1-1.2% 25kg/barrel
. - Good solubility in water. Antibacterial.
1,3-propanediol. .
- Easy to use, Both cold and hot, and good thermal stability.
Phenoxyethanol + Broad-spectrum antibacterial. Antiseptic
DropPrev® PE91 i ? P . i P l_ ’ 0.1-1% 25kg/barrel
Ethylhexylglycerin - Good safety, good water solubility. Antibacterial.
- Broad spectrum antibacterial, strong antibacterial activity. . .
Caprylyl glycol, K . . . Antiseptic,
DropPrev® EC10 . - No anti-corrosion claims, high safety. . . 0.5-1% 25kg/barrel
Ethylhexylglycerin Antibacterial.
- Water soluble below 0.5%.
BEAUTY

AEETY
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B Emulsifier

Trade Name

INCI Name

Properties

RECR - GREE
Little by little - Make the future

Dosage

Package

- Non-ion emulsifiers derived from natural plants, EO free;

Main emulsifier:

i Emulsi 3.0-5.0%
DropCare® CG68 Cetearyl Glucoside, - Unique liquid crystalline emulsified structure; ,fy’ _0’ 20kg/barrel
Cetearyl Alcohol o ) Hydrating. Co-emulsifier:
- Safe and non-irritating, can be fully biodegraded.
1.0-3.0%.
+ The HLB value is 16.
- Oil-in-water system, non-PEG emulsifier.
- It is especially suitable for low viscosity formulations. Emulsify, 1kg/bag
DropCare® Sucro S160 Sucrose Stearate ) . ) . 0.5-5%
- Suitable for sunscreen systems with high SPF values. Hydrating. 25kg/barrel
- Excellent biodegradability, non-irritating to the eyes and
skin.
- It is a nonionic-solubilizer and emulsifying agent obtained
by reactingl5 moles of ethylene oxide with 1 mole of 12-
DropCare® HS-15 PEG-15 Hydroxystearate | o0 Stearic acid. Emulsify, 0.5-10% 20kg/barrel
ropCare® HS- - roxystearate .5- arre!
P yaroxy - The hydrophilic-lipophilic balance lies between 14-16. Hydrating. ’ ¢/

- The critical micelle concentration(CMC) lies between
0.005% and 0.02%.

J Self-tanning

TradeName

INCI Name

Properties

Efficacy

Dosage

Package

+ Microbial fermentation, high safety.

- It works directly with the skin to produce pigment that

Tanning agent,

. . gives a natural, healthy tan, protecting the skin from the . 1kg/bag
DropBio® DHA Dihydroxyacetone Sun-screening 0.5-5%
damage caused by sun exposure. agent 25kg/barrel
- Color fast, deep, and avoid the risk of UV sunburn for a gent.
healthy dark brown complexion.
- Microbial fermentation, friendly and safe for skin and )
i Tanning agent,
) environment. . 1kg/bottle
DropBio® DHB Erythrulose i K i Sun-screening 0.5-10%
- gives the skin a more natural, even, and long-lasting color. agent 25kg/barrel
- No strong drying reaction, no odor, no irritation. gent.
Dihydroxyacetone, PEG-8
C lic/Capric Gl id, Tanni 1t
DropBio® DHA 0ilS aprylic/Capric Glycerides, | 0il dispersion, can make oil base formula. anning agt?n ’ 1kg/bottle
Octyldodeceth-25, Aqua, . . o Sun-screening 5-20%
(30%) - High content version, good stability. 25kg/barrel
PEG-40 Hydrogenated Castor agent.
0il, PEG-26-Buteth-26
Dihydroxyacetone
A ’ . . Tanning agent,
. Erythrulose, Aqua, - Comprehensive scheme, color more uniform. . 1kg/bottle
DropBio® Selftan 50 . A ) o Sun-screening 5-20%
Hippophae Rhamnoides |- Prevent light damage, repair skin. agent 25kg/barrel
Extract. )

J Others

TradeName

INCI Name

Properties

Efficacy

Dosage

Package

Cream, lotion,

facials,
toothpastes:
- Very safe food grade raw materials; 01 E 3
DronCare® VBE Vanillvl Butvl Eth - Long lasting thermal effects on the skin; Heat agent, Steady Sl" o 0’ —
roprare anillyl Buty r + A small amount of heat agent added in cold agent can the fragrance. 1mmlng g/botlie
. . . massage-oil:
improve the cold feelings on the skin.
0.3-0.5%,
Eyes care:
0.1-0.2%.
- High purity, odorless.
L. - Alkaline amino acids, adjust the pH value of the formula, N .
DropCare® L-AGE Arginine X R Moisturize. 0.05-1% 25kg/barrel
can also be used in hair dye products, more safe.
- Moisturize the skin and prevent dandruff.
- High purity, odorless.
DropCare® Trom Tromethamine gh purity, Adjust pH. 0.05-1% 25kg/barrel

- Amino buffer base can adjust the pH of the system.
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